STP Statistics

Homework 1—Excel Basics (Version 2007)
Excel is a software program that is used to organize information, perform calculations, and create visual displays of the information.  When you start up Excel, you will see the following grid, which is called a spreadsheet.
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Each box is referred to as a cell.  Each cell can hold text or numbers.  Each cell is uniquely referenced by its column letter and row number.  For example, cell B2 is located in column B and row 2.  To enter information into a cell, click on a cell and type in the information.  

NOTE: This packet is for Excel version 2007.  If you have an older version of Excel, see the Excel Basics packet on the course website (http://faculty.washington.edu/tamre/stp.shtml)
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Note that the text you type into a cell appears above the spreadsheet, as circled in the picture above.

To open a file, click on the File pull-down menu in the top left corner of your screen, and choose Open.  Select the file on your computer and click Open. 

For this exercise, open the data file called “ExcelBasicsDataSet.xls”.  To get a copy of the data set, go to the course website http://faculty.washington.edu/tamre/stp.shtml and select the Data Sets link found on the upper left of the page.  This will open a page that has a link to the data set you need.  Click ExcelBasicsDataSet.xls to access the data set.  You should get a dialog that allows you to either Open or Save the file.  Make sure to save a copy of the Excel file clicking Save and entering a name for the file—make sure you pay attention to where you save the file so that you can open it from Excel.  This file contains some sample data that you will use to practice various to complete the rest of this exercise.  The first tab in the file contains the data.  The second tab contains a description of the variables in the data set.
USING FORMULAS

SUM

Next, sum the total writing score for the 30 students in the sample. To do this, click on a blank cell in your spreadsheet.  To tell Excel to use a formula to perform a calculation, you must start with an equal sign.  For example, to calculate a sum, enter the following into the blank cell:

=SUM(

Then use the mouse to select the group of cells you wish to sum and press Enter.  Note that Excel enters the reference to the cells you select and this becomes part of your =SUM, so you end up with =SUM(D2:D31)—you must remember to enter the closing “)”.  You can also enter the cell references manually with the keyboard, rather than selecting them with the mouse.  If you entered the formula correctly, you should get a sum of 8411.
In the cell next to your calculated sum, type some sort of description of what that number means, such as "Sum of Writing Scores". 
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What if you were interested in the sum of writing scores, by gender?  A useful tool for doing this is Pivot Tables.  
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Select PivotTable from the Insert Toolbar. [image: image3.png]Insert
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To enter the Range, use the mouse to select all of the data, including the variable labels.  You have the choice of having the Pivot Table written to a new worksheet or put in the existing worksheet.  If you want the table to remain in the existing worksheet, choose an empty cell that will become the top, left-hand corner of the table (recommend cell A34).  Notice that the variable names show up in a panel on the right hand of the Excel window.  Click on gender and drag it to the area labeled ROW; click on write drag it to the area labeled DATA.  If you have done this correctly, your spreadsheet should look like the screen shot below.
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Notice that it breaks the scores out by gender (remember 1 = female and 2 = male).  f you did this correctly, you should get a sum of 4346 for females and 4065 for males.  Notice that 4346 + 4065 = 8411, the sum of all writing scores we calculated using the SUM function.
Next, repeat the process above for the sample math scores.  Instead of creating a whole new pivot table.  We can update our table to include the sum of the math scores.  Do this by checking the “math” field in the “Pivot Table Field List” in the right-hand panel as indicated by an arrow in the above screen shot.
AVERAGE (MEAN)

To calculate the mean (average) writing score, click on another blank cell, and type the following:

=AVERAGE(

then select the group of cells to take the average of as you did before for the sum.  Be sure to include a description in the cell next to this number.  Do this for both the writing and math scores.
Next, calculate the average writing and math score for each gender separately.  This can easily be done using the Pivot Table function.  Again, you do not need to create another Pivot Table.  You can add another column to your pivot table using the right-hand panel.  In this panel, drag the “write” variable down to the box labeled “Values”.  You can also do this by right-clicking the “write” variable and choosing “Add the Values”.
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This added another column that sums the writing scores by gender.  To get the average, double-click on the cell that says “Sum of write”.  Now select Average from the Summarize by drop-down list.  Press OK.  The Pivot Table now displays averages, by gender, for the write variable.  If done correctly, you should get the overall average as 280.37, with an average of 289.73 for females and 271.00 for males.
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Repeat this process to find the averages for the math scores (overall and by gender).

MEDIAN

To calculate the median writing score, find another blank cell, and type the following:

=MEDIAN(

and select the group of cells as before. Be sure to include all students.  
Which is bigger, the mean (average) or the median?
MODE

The formula for calculating the mode is:

=MODE(

Use this function to find the mode of the writing data. Don't forget to include a description!

STANDARD DEVIATION

The formula for calculating the standard deviation is:

=STDEV(

Calculate the standard deviation for the writing data, and include a description.

QUARTILE

The quartile formula can be used to calculate the minimum value, the lower quartile, the median, the upper quartile, and the maximum value.  Enter the formula as below:

=QUARTILE(

Then select the group of cells (write), and press the comma, ",". Next, enter one of the following numbers, depending on which quartile you'd like:

0
Gives the minimum value 

1
Gives the lower quartile (25th percentile)

2
Gives the median

3
Gives the upper quartile (75th percentile)

4
Gives the maximum value

In your spreadsheet, use the QUARTILE formula to calculate these 5 values. Be sure to label each one correctly. 

Using the functions described above, find the median, mode, standard deviation, and quartiles for the math variable.  Just do this for all students.  Compare the mean and the median.
MAKING GRAPHS

BARPLOT

Excel needs to have counts of how many individuals fall into each group in order to make a bar plot.  We will make a barplot of responses to the esteem question.  To start, you need to count how many students came from each of the four possible esteem categories (strongly disagree, somewhat disagree, somewhat agree, and strongly agree).  You can either count these up by hand (sorting or filtering the data can make this relatively easy for a small data set) or, you can use the Pivot Table dialogs to get the counts.  Once you have the counts, enter them into cells K2 through K4.  In cells L2 through L4, enter esteem response labels (Strongly disagree, Somewhat disagree, Somewhat agree, and Strongly agree).  
To make a bar plot, use your mouse to highlight the column of counts.  Then click on the Insert toolbar tab at the top of your screen and select Bar (2D).  (A blank chart area will appear)
Next click the “Select Data” button at the top of the screen.  In the “Chart data range” field, select the count data we stored in cells K2 through K5.  Note: your chart should look a bit different, as the numbers were changed for this example.
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Next, we want our chart to be have the esteem response labels (strongly disagree, somewhat disagree, etc).  In the “Select Data Source” window, click the “Edit” button in the Axis Labels window.  Then choose the labels we stored in cells L2 through L5
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Using the “Chart Tools” “Layout” toolbar tab allows us to add chart title, horizontal axis title, vertical axis title, and remove the “Legend”, since it is not really necessary.
SCATTERPLOT

Scatterplots are useful look at the relationship between two quantitative variables.

Select the two columns labeled “write” and “math” with your mouse—just select the data, not the column labels.  Click on the Insert tab and choose Scatter plot with only markers (i.e., no lines connecting points). 

Add titles to your plot using “Layout” tab at the top of the screen. Add an appropriate title (optional), and be sure to label the x-axis as the “Writing Score”, and the y-axis as the “Math Score”.  Under the Legend button, choose “None”—there is no reason to include a legend on a scatter plot when you only have one set of data. 

Note:  when you choose two columns at a time to create a scatterplot, Excel automatically uses the first column as the x variable (on the horizontal axis) and the second column as the y variable (on the vertical axis).  You can control which variable is assigned to x and y by opening up the “Select Data” dialog (button is in the “Design” toolbar).  In the “Select Data Source” dialog, choose “Series 1” and click “Edit”.  Then you can select the data you want for the “Series X values” and the “Series Y values”.
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Insert this chart as a new sheet.  To do this, click on “Move chart” button under the “Design” toolbar.

[image: image10.png])
Home.

i, @ E

Save As
Chart Type Template

Change

AVE AN

Insert

Page Layout

Formulas  Data

Review  View

Switch  Select

Row/Column Data

Chart Tools. ExcelBasicsD:

| Deson | toyout_ Fomat

asetxls [Compatibility Mode] - Microsoft Excel

Choose where you want the chart to be placed;

Move
Chart

Loaatior

Toe oata crar tayouts NTMJ Orme
Chart6 - £
A B G D E F G
1 case school write math esteem 0 [} ‘ O obfectim
2 1 1 1 286 279 1 5
3 2 2 2 281 321 3 5
4 3 1 1 306 341 3 7
5 4 1 1 300 298 3 8 Mean math 8 Strongly Agree
6 5 1 3 211 303 3 5 Mean witing
7 6 2 3 290 312 4 6
8 7 1 3 292 301 4 6 ‘median math
9 8 1 1 257 332 2 6 ‘median wiiting [Count of esteer]
10 9 2 2 27 350 1 5 [esteem |~ [Total
1 10 2 2 278 320 4 8 ‘mode math 1 4
12 1 1 1 31 3 8 ‘mode witing 2| 5
13 12 2 3 273 3 6 3 10)
" 13 2 2 265 4 8 SD math 4 1
15 14 2 2 29 “Fand Total 30
z x 2 2 = Relationship between Writing and
18 7 1 1 284 2 Math Scores
19 18 2 2 285 3
20 19 1 1 254 2 400
21 20 1 3 301 330 w
2 21 2 3 23 3 ®
23 2 1 3 323 g = *
2 2 1 1 3 P
z 2 2 2 o 25 @series
27 2 2 2 280 *
2 27 2 3 241
2 % i 3 289 0 50 100 150 200 250 300 350
0 2 2 2 283 Wiitingscores
31 20 1 1 254 2|
% 2
3
3 [Data
[Sum of Average of  Average of

35 |gender ~|math__ Sum of wite _ write math
3 A 4591 4306 2897333333 306.0666667]
37 2| 4709 4065 2713139333333
38 Grand Total 9300 8411280 3666667 310
39
40
4
42
43
44
M 4 » M| Data, Description ¥ A L m
Reagy | 2951653333 Count 60 Sum: 17711





Your completed scatterplot should look something like the plot shown below.  Notice the how Excel defaults the scaling of the x- and y-axes.  There is a lot of wasted “white space,” which can often make it hard to see potential patterns in the data.
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To rescale the axes, click on the “Layout” toolbar.  Under the “Axes” menu, choose the axis you want to change (eg, Primary Horizontal Axis), then choose “More Primary Horizontal Axis Options”. [image: image12.png]ExcelBasicsDataset s [Compatibility Mode] - Microsoft Excel
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Under “Axis Options”, change the minimum from “Auto” and set it to be Fixed at 200.  Do the same for the y-axis (Vertical axis).   
You can experiment with other chart options if you would like.  For example, you can change the shape, size, and color of the plotting symbols by selecting one of the symbols with the mouse pointer and then right-clicking.  After you right-click, select Format Data Series…  Other options can be found by pointing to different parts of the plot and right-clicking.  Your final chart should look something like:
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Print only the chart; don't worry about printing the data for this graph.  On your printout (or in your word document), write a sentence that describes the observed pattern between the math and writing scores.
Homework 1: To Turn In

(due Wednesday 5 August by 8:30pm at IC)

Turn in a computer print-out that includes: 

· sum, average, median, mode, standard deviation, and quartiles that you calculated for both the writing and math scores.  Compare the mean and median math scores.

· sums and means by gender for the writing and math scores. 
· Barplot of self-esteem responses

· Scatterplot.  Describe the observed pattern between the math and writing scores
You can either turn in a nicely-formatted printout from Excel, or a Word document that you have copied all of the results into – the key is to make sure that whatever you turn in has all of the results and graphs you created in this exercise, in a clear and readable format—everything should be appropriately labeled.  If you plan on printing from the Excel file, be sure to use the Print Preview dialog found under the File drop-down menu in order to make sure the material you print is appropriately formatted.  Ask if you need help formatting the output.
Don’t forget your first and last name and section TA name.
Summary References
A3:A8

cells A3 through A8

A3, A8

cells A3 and A8, no others

Formulas

=SUM(cells)



returns the sum of the selected cells

=AVERAGE(cells)


returns the mean of the selected cells

=MEDIAN(cells)


returns the median of the selected cells

=MODE(cells)


returns the mode of the selected cells

=QUARTILE(cells, quartile)

returns the quartile (0,1,2,3 or 4) of the selected 







cells. 0 returns minimum, 1 returns 1st quartile 







(lower), 2 returns median, 3 returns 3rd quartile 







(upper) and 4 returns maximum.

=STDEV(cells)


returns the standard deviation of the selected cells
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